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 Office Connectivity Script 

Clip Link: http://www.priority-software.com/eshbel.com/Movie_Search/office_connectivity_clip.htm 

Note: Yellow highlights indicate action instructions.  

*HEADINGS ARE NOT MEANT TO BE READ ALOUD. 

BEFORE YOU BEGIN:  

SET UP PRIORITY CUSTOMERS "SILVERMEDIA"  AND "BIOTEC". FROM THE CONTACTS PANE IN 

OUTLOOK 2007, ARRANGE THE CURRENT VIEW "BY CATEGORY". MAKE SURE SEVERAL 

"BUSINESS" E-MAILS APPEAR IN THE INBOX AND SENT ITEMS FOLDERS IN OUTLOOK (AND 

NOTHING PERSONAL). MAKE SURE THERE IS AN E-MAIL IN THE INBOX FROM A CONTACT WHO IS 

LINKED TO CUSTOMERS "SILVERMEDIA" AND "BIOTEC" (INBAL@ESHBEL.COM) AND ANOTHER 

FROM A CONTACT WHO IS NOT LINKED TO ANY CUSTOMERS (R@R.COM). ORGANIZE SUB-LEVELS 

OF TASKS FORM SO THAT NOTES APPEARS FIRST. SET UP SEVERAL TASKS IN PRIORITY THAT 

WILL BE SYNCHRONIZED WITH OUTLOOK, AND AN "APPOINTMENT" WITH MULTIPLE PARTICIPANTS, 

SOME OF WHOM ARE NOT INTERNAL USERS. SET UP CUSTOMER RELATIONS DATA THAT WILL 

SHOW UP IN EACH OF THE TABS FOR THE DEFAULT "THIS MONTH" VIEW. SET UP SOURCE X IN THE 

SOURCES OF LEADS/SALES OPPS FORM.  

Introduction (00:00-00:22) 

Most business users consider Microsoft Office a necessary tool to fulfill their daily 

assignments. As such, the entire Office suite is tightly integrated into Priority. In this video, 

we will demonstrate how to work with several of Priority's built-in Office integration and 

synchronization tools.  

Priority on Outlook (00:23-01:16) 

Let's begin with Microsoft Outlook, widely considered to be the standard email and 

calendaring application. With the proper license and setup, you can run Priority seamlessly 

on Microsoft Outlook by means of a variety of dashboards. You can also view or update 

select types of data and run various dynamic BI reports directly from Outlook. 

Additional details on designing and using dashboards and BI reports are provided 

elsewhere. For now, we're just going to look at how you can display a selection of 

dashboards, add-ons and BI reports in your local installation of MS-Outlook. Your choices 

will not affect the display of any other user in the system, or the dashboards and reports 

that are available in Priority menus.  

Setting Up Priority on Outlook (01:17-02:12) 

Run the Priority on Outlook program, accessed from the Office Management, Priority on 

Outlook menu item. Click the Dashboards tab and flag each dashboard that you want to 

be available in Outlook. 

Next, click the BI Reports tab and select any BI reports that you want to be available in 

Outlook. 

Finally, click the Add-ons tab and flag each item you want to include in Outlook. 
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Displaying Priority on Outlook (02:13-02:37) 

Now we're going to open Outlook and click the Shortcuts  icon in the navigation window 

to the left. Shortcuts to the add-ons dashboards and BI reports that you chose appear 

under the titles Priority Add-ons, Priority Dashboards and Priority BI Reports, 

respectively[POINT TO EACH]. [EXPAND ANY TITLE TO DISPLAY SHORTCUTS - MAY 

NEED TO COLLAPSE ONE FIRST SO YOU CAN SHOW HOW TO EXPAND IT]. 

Operating Add-ons in Outlook (02:38-08:44) 

Let's begin with the Priority Add-ons section and click Customer Relations to open a 

tabbed report displaying several different types of customer relations management data. 

Click any report tab to view different types of data[CLICK THROUGH ALL]. Each report tab 

is fully interactive; for example, you can retrieve data in various cross-sections, click 

individual data fields to activate other forms, and create new records as needed, either 

manually or by copying an existing record.  

We'll demonstrate how to work with the Customers tab[RETURN TO THE Customers 

TAB], but the other tabs can be used in a similar fashion. 

When you first open this tab, data is displayed for the default View format, called "This 

Month". Let's click More to see the criteria that determine what data are displayed for this 

View format, and use it as a basis for creating our own custom View format. 

As you can see, the current View format is defined only by the range of dates on which 

customers were opened[POINT OUT From Date & To Date]. Let's click New to create a 

new View format using different criteria. 

Record a name for the new View format. 

Use the available fields to indicate the desired customer Status, the user that customers 

are Assigned to, and the relevant sales Rep. You can also indicate whether you'd like to 

include all customers that meet the above criteria, or limit the report data to active 

customers only. When you are done specifying the desired criteria, click Go to retrieve the 

corresponding records. The next time you enter this report tab, you will be able to use these 

criteria to retrieve data by simply choosing the desired View format from the Choose list. 

Once data is displayed, you can click on any column title[e.g., Date Opened] to sort the 

displayed data by the values in that column. 

Besides using View formats to retrieve multiple customers, you can also retrieve a specific 

customer by selecting them from the Choose list[CHOOSE A CUSTOMER IN THE Cust 

LIST AND CLICK Go]. 

You can also use this tool to open a new customer record [CLICK New]. Use the form that 

opens to record customer data[RECORD NAME AND ADDRESS], just as you would if you 

were working in the Customers form in Priority itself[CLICK Details TAB]. All Choose lists 

that appear[CHOOSE A Sales Rep] are populated with the relevant Priority data. Once 

you click Save, the new customer is automatically assigned a customer 

number[HIGHLIGHT] and the record is saved into the Priority database. You can also click 

Save & New to clear the form after the record is saved, in order to record another new 

customer. 
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When you are done defining customers, you can return to the previous screen by clicking 

Back. 

If you want to clear the population displayed in order to display a different one, you can do 

so either by clicking More[POINT] and define the desired View format, as we did earlier, or 

by selecting an existing View format from the Choose list. When you are ready to retrieve 

the new data for display, click Go. 

You can view additional data for any of the displayed customers by simply clicking on a 

customer name. The form that opens displays additional data for the customer in 

question[CLICK Details TAB] and can also be used to modify customer data. All Choose 

lists that appear[CHOOSE A Sales Rep] are populated with the relevant Priority data, just 

as if you were working in the Customers form in Priority itself. You can then save your 

changes[CLICK Save] directly to the Priority database. Click any of the provided links to 

view still more data, such as tasks or sales opportunities that were opened for this 

customer. If a valid address is defined for the customer, you can also view a map[CLICK 

Map] of the address in Google Maps. You can even send[CLICK Send] a link to the 

customer record[FLAG Incl. Record Link] in an email.  

The Calendar (08:45-09:04) 

The Add-ons section can also be used to access your appointment Calendar. You can use 

this Calendar to view and revise scheduled appointments, just as you would in Priority itself. 

Detailed information on working with tasks and appointments is provided elsewhere. 

Displaying Dashboards in Outlook (09:05-10:14)  

The first time you work with Priority on Outlook, click on My Dashboard and make sure the 

User Preferences window is visible. Use it to set up the data you will be viewing[SELECT A 

COMPANY]. For instance, if your organization maintains Priority data in several different 

company environments, you can select the company for which to display data.  

Then click on one of the dashboards in the list. The dashboard will be displayed in the main 

area of the screen. You can then work with the dashboard and any of its web parts as 

usual. Use the vertical scroll bar[TO THE RIGHT] as needed in order to move from the 

upper to the lower part of the screen. 

In order to display the dashboards in a wider window, press Alt+F1 to close the navigation 

window to the left of the screen. To restore the navigation window, press Alt+F1 again. 

Running BI Reports in Outlook (10:15-10:31) 

Similarly, you can run any of the available BI reports directly from Outlook, and then fine 

tune and view the data you need in the format of your choice. 

Synchronizing Appointments, Contacts and To-Do Items with Microsoft Outlook 

(10:32-11:08) 

Outlook synchronization is another powerful feature that can greatly boost efficiency. In fact, 

once you begin working with it, you will probably find it indispensable. Priority's bilateral 
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interface with MS-Outlook facilitates appointment, contact and task maintenance in and out 

of the office. Specifically, it can be used to: 

 synchronize calendars, 

 import customer and vendor contact information from Outlook to Priority, 

 create new tasks and service calls based on Outlook e-mail messages, and 

 update Outlook tasks with to-do items. 

Preparing for synchronization in Priority (11:09-11:55) 

Before running the Outlook interface for the first time, make sure your system manager has 

performed all the necessary setups, as outlined elsewhere. In addition to this initial setup, 

periodic maintenance is also required in order to control how your calendar and contacts 

are synchronized with Priority. For example, task codes and task types must be defined to 

Interface w/Outlook[OPEN Task Codes FORM - MENU PATH CRM > Customer Relations 

Management > CRM Definitions - AND FLAG A CODE TO Interface w/Outlook] if you plan 

to export tasks from Priority to Outlook. In addition, you may want to define a source to 

assign to any leads that are opened automatically from Outlook[OPEN Sources of 

Leads/Sales Opps FORM - SAME MENU PATH - AND FLAG SOURCE X IN THE Outlook 

COLUMN]. Additional information on these and other maintenance requirements is provided 

elsewhere. 

Preparing for contact synchronization (11:56-14:08) 

You'll also need to set up a few things in Outlook[OPEN OUTLOOK] to facilitate 

synchronization. For instance, you'll need to set up colored categories that will be used to 

synchronize contacts with Priority[MOVE TO THE CONTACTS PANE]. 

During synchronization, Priority imports any Outlook contacts that are assigned a 

designated category color, for instance, the color Black. So lets begin by setting up a 

general category[Edit > Categorize > All Categories > New], we'll call it "Sync"[Name: 

Sync], and assigning it the color black. If a particular contact is associated with more than 

one customer in Priority (e.g., in the case of a reseller that works with several different 

customers), you can create additional Outlook categories and use them to distinguish 

between the customers. To this end, you'll need to create a separate category for each 

customer[CREATE A CATEGORY CALLED Multiple cus.], using either their Priority 

customer number or a unique string from the Priority customer name. Make sure each new 

category is assigned a color[Black] indicating that contacts in this category should be 

synchronized.  

Let's take a moment to understand how contacts are synchronized, in order to better 

understand how these categories should be used. 

When contacts are imported from Outlook to Priority, existing contacts are identified by 

name and e-mail address, as well as by customer category, where one has been assigned. 

If a corresponding contact is located in Priority, Outlook data will be used to update that 

contact. 
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If no such contact exists in Priority, a new record is generated automatically. If the contact 

in question is assigned a customer category in Outlook, a corresponding Priority contact is 

created and linked to that customer. Otherwise, the contact is imported as a lead and 

assigned the designated source (i.e., Source outlook). 

The appropriate categories can be assigned to each contact at any time before 

synchronization is run, regardless of whether you are working in online or offline mode at 

the time. Let's go ahead and do so now[ASSIGN CATEGORIES TO SEVERAL 

CONTACTS - SOME "NEW" AND SOME THAT ARE ALREADY DEFINED IN PRIORITY]. 

Preparing for calendar synchronization (14:09-15:04) 

Next, we'll move on to the calendar[MOVE TO THE CALENDAR PANE]. When calendars 

are synchronized, all of your existing appointments in Outlook are copied into your calendar 

in Priority, and/or vice versa. If the appointment already exists in the receiving calendar, its 

details are updated. If it does not, it is added. If you do not want a particular Outlook 

appointment to be imported during synchronization, simply flag it ahead of time as Private. 

Here's a quick example of how this type of synchronization might be used. Suppose your 

secretary schedules a meeting for you in the Priority calendar, which is then synchronized 

with Outlook. Once the meeting is over, you can record its outcome in Outlook and then 

synchronize the data with Priority upon returning to the office. Additional updates can then 

be made directly in Priority.  

Preparing for e-mail synchronization (15:05-23:47) 

Next, you'll need to define synchronization parameters for Outlook e-mail messages, and 

indicate which messages to synchronize. This can be done directly in Outlook, even when 

working in Offline mode, provided that up-to-date Priority data (such as customer numbers) 

are maintained on the workstation in question. 

To this end, you need to  export Priority data for synchronization with Outlook by running 

the[Office Management > Mail > Synchronize With MS-Outlook] Update Data for 

Synch w/Outlook program. The first time you run this program, you'll be able to set up 

periodic updates [FLAG Update data atutomatically], which are performed automatically 

each time you log in to Priority. 

Once all preliminary data are in place and you have restarted Outlook, you are ready to 

begin flagging e-mail messages for synchronization and defining synchronization 

parameters for individual messages. 

Let's take a moment to understand how messages are synchronized, in order to understand 

which parameters to define and how these definitions will be used. 

Each message can be imported into Priority[MINIMIZE OUTLOOK TO SHOW PRIORITY] 

as either a task or a service call. When e-mail messages are imported as tasks, these are 

opened in the Tasks form[OPEN FORM] and assigned to you, unless another user is 

specified in Outlook. The contact for the task[SHOW COLUMN] is determined by the e-mail 

address. The customer or vendor for the task[SHOW COLUMN] is also determined by the 

contact, provided that this individual is directly associated with a single Priority 

customer/vendor. If the contact is associated with more than one customer or vendor, or if 
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you want to specify the customer/vendor yourself, you can indicate a particular customer or 

vendor directly in Outlook. The message text is copied to the Notes sub-level form[SHOW] 

and the message itself is added as an attachment to the task in the Customer Documents 

for Task sub-level form[SHOW; CLOSE FORM]. 

When e-mail messages are imported as service calls, these are opened in the Service 

Calls form[OPEN FORM] for a customer associated with the recipient/sender of the mail. 

Again, this is determined either by the customer assigned to the e-mail message or by a 

direct link between the contact and customer in the Contacts form. The message text is 

copied to the Details of Malfunction sub-level form[SHOW; CLOSE FORM]. 

Now that we've explained how synchronization parameters are used, let's return to Outlook 

and begin defining these parameters for the messages we wish to import. One way to do 

this is to simply right-click any item in Outlook and select Synchronize with Priority. In the 

Synch Parameters dialog box that opens, choose whether the current message will be 

imported as a task or a service call[FLAG Open Service Call] and make sure it is flagged for 

Synch w/Priority. Additional parameters can be defined from here as well. 

Alternatively, you can customize the view in your Outlook messages pane to make this 

process quicker and easier. In Outlook 2007, customize the current view from the View, 

Current View menu item[View > Current View > Customize Current View]. In the dialog 

box that opens, click Group By, clear the Automatically group according to 

arrangement check box, and then click OK. 

You can then use Outlook's Field Chooser tool[RIGHT-CLICK ANY COLUMN HEADING 

AND SELECT Field Chooser] to add user-defined fields to Outlook [CLICK TOP ARROW 

IN THE Field Chooser, SCROLL ALL THE WAY DOWN AND SELECT User-defined 

fields in Inbox], based on any of the parameters used for synchronization with 

Priority[DRAG EACH OF THE FIELDS INTO THE HEADER BAR]. The same procedure 

can be used to add user-defined fields to other Outlook folders as well (e.g., Sent Items). 

We're also going to enable in-cell editing in Outlook[RIGHT-CLICK ANY COLUMN 

HEADING, SELECT Customize Current View, CLICK Other Settings, FLAG Allow in-

cell editing AND CLICK OK]. This allows you to edit or flag columns within the Messages 

pane, making synchronization even more efficient. That is, you can now simply define 

synchronization parameters for each message directly within the Messages pane, and then 

flag the message in the Synchronize with Priority column to include it in the next 

synchronization. 

Let's quickly focus on two of the messages we'd like to synchronize with Priority. The first 

message[IN OUTLOOK, HIGHLIGHT A MESSAGE FROM Inbal ] was sent from an e-mail 

address that's already been recorded in Priority[OPEN Contacts FORM AND RETRIEVE 

BY E-mail Address: inbal@eshbel.com]. Note that the sender appears both as a 

Customer Contact for the BioTec company[OPEN Customers FORM, RETRIEVE BioTec 

AND SHOW CONTACT IN Customer Contacts SUB-LEVEL FORM] and as an Additional 

Contact for Silver Media[RETRIEVE Silver Media IN Customers FORM AND SHOW 

CONTACT IN Additional Contacts SUB-LEVEL FORM]. Since this contact is currently 

linked to more than one customer, we'll have to choose which customer this message 
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should be associated with when synchronization is performed. We can do so right now from 

within Outlook itself[RIGHT-CLICK Synchronize with Priority], by simply selecting the 

desired customer from a Choose list[OPEN Customer CHOOSE LIST]. This list is 

populated with all of the customers defined in Priority at the time the Update Data for 

Synch w/Outlook program was last run[SEARCH FOR & SELECT BioTec]. 

As you will shortly see, Another sender[IN OUTLOOK, HIGHLIGHT A MESSAGE FROM 

Jane Lin] has not yet been linked to any customers in Priority[OPEN Contacts FORM AND 

RETRIEVE BY E-mail Address: janelin.igoyougo@gmail.com]. We can indicate right here 

in Outlook[RIGHT-CLICK Synchronize with Priority] that the email from this sender 

should also be linked to the BioTec Company[OPEN Customer CHOOSE LIST& SELECT 

BioTec]. Depending on how your system is set up, a new contact may also be created for 

the sender when synchronization is performed; this contact would then be linked to the 

same customer. 

Note the subject for the second message: "Price Quote No. PQ12000005". Tasks created 

from mail messages such as this one are automatically linked to the relevant document in 

Priority once synchronization is performed, provided that the full document number 

appears in the subject line. 

Use Outlook's standard grouping and sorting tools to arrange messages according to any of 

the user-defined fields you added. For instance, you can use these tools to easily locate all 

messages that are being imported as service calls, and sort them by customer[GROUP BY 

Open as Service Call in Priority, SORT BY Customer]. 

Setting Up Synchronization Options in Priority (23:48-26:24) 

Finally, we're ready to perform the synchronization itself. The first time you run the 

synchronization program, you'll have to do so manually and indicate the types of data you 

want to synchronize. You'll also be able to set up periodic updates, which will be performed 

automatically, at the designated intervals. 

To do so, let's minimize Outlook and open the Synchronize with Outlook dialogue box 

from the Mail menu on the Priority Top Bar. 

In the first section, indicate whether you want to synchronize calendars and in which 

direction synchronization should be performed[SELECT Update Both].  

In the next section, indicate whether to import contacts from Outlook[FLAG] and designate 

the category color[UNDER Task DEFINITIONS NEXT TO Use Color, SELECT "Black"] 

used to identify the Outlook contacts to be synchronized — black, in this case[SHOW 

OUTLOOK, MOVE TO CONTACTS PANE, SHOW CONTACTS THAT ARE ASSIGNED 

THE "SYNC" CATEGORY]. We'll also specify the color to be assigned once 

synchronization is complete[SELECT "NO COLOR"]. Since we define synchronization 

parameters for messages directly in Outlook, we can skip the rest of this section. 

In the third section, indicate whether to update Outlook tasks based on your to-do 

list[FLAG]. If this option is flagged, any item appearing on your Priority to-do list and 

assigned to you (e.g., a sales order you are responsible for) will be transferred to Outlook 

tasks. 
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If you have multiple mail folders defined in Outlook, specify the Outlook Folder to be 

synchronized. Similarly, if you work with multiple companies in Priority, you must also 

specify the Priority company with which to synchronize Outlook. Outlook will always be 

synchronized with the specified company, regardless of the Priority company in which you 

are working at the time of synchronization.  

Finally, we're going to schedule automatic synchronization with Outlook[FLAG 

Synchronize automatically... AND INDICATE DESIRED INTERVAL]. You can also run 

the synchronization program manually by clicking Sync Now[CLICK]. 

Viewing Results in Priority (26:25-27:49) 

Once synchronization has been performed successfully, you can view the results in the 

relevant Priority form. For instance, we can open and update the tasks we just created for 

the BioTec customer[OPEN Tasks FORM TO VIEW TASKS CREATED FOR THE BioTec 

CUSTOMER, EDIT CONTENTS IN Notes SUB-LEVEL FORM. IN TASK FOR "Jane Lin", 

CLICK References TAB AND SHOW LINK TO PRICE QUOTE]. 

Similarly, you can open your Priority calendar[MENU PATH: Office Management > 

Calendar Maint. & Office Hours > Calendar] to view any new appointments created 

during synchronization, and view new or updated contacts in the Leads and Contacts 

forms[OPEN Leads FORM TO VIEW NEW LEADS, SHOW THAT THESE ARE ASSIGNED 

SOURCE Outlook]. 

Sending Appointment Information (for Outlook) to Participants (27:50-29:14) 

You can also send appointment details to participants who may not have access to Priority 

(e.g., users working remotely, and customer or vendor contacts). The scheduling 

information recorded in Priority[OPEN Tasks FORM AND RETRIEVE AN 

"APPOINTMENT"] (e.g., participants, start time, end time)[POINT TO EACH COLUMN] is 

sent to participants as an e-mail attachment, which can be uploaded directly into the 

recipient's Outlook calendar. Before you begin, make sure that e-mail addresses are 

defined in Priority for all participants[PRESS F6 TO ZOOM TO A PARTICIPANT AND 

RECORD AN E-MAIL ADDRESS FOR THEM].  

To send appointment information, return to the Tasks form and retrieve the desired record, 

then select Send Outlook Msg to Participants from the list of Direct Activations. Note that 

the e-mail attachment created by this program is not limited to use with Outlook, but may 

also be viewed and uploaded into other scheduling programs. 

Sending Report/Report Data to MS-Office (29:15-32:54) 

When running a report in Priority,[e.g., CRM > Customer Relations Management > CRM 

Reports > Tasks per Customer] users can choose to generate a new report or access a 

report that was run previously, that is, a saved report. In either case, unless you specify 

otherwise, the finished report is displayed in an HTML page. You can then use any of the 

standard browser options to save or print the page. You can also use the icons that appear 

at the top of the report to export the report data to Excel, Word or Outlook, 

respectively[POINT TO EACH].  



 

  www.pr ior i ty-sof tware.com  

9/9 Apr. 11,'19 Ver. 03 Cat.No. LB120048 

 

Alternatively, you can bypass the HTML page altogether and send the report directly to MS-

Office. If you are running a new report, you can select the Send to Excel option before 

generating the report in order to send report data directly to an Excel spreadsheet. If you 

are running a saved report, you can choose to send the report to MS-Word, or attach it to 

an e-mail[SELECT EACH]. 

Similarly, all documents that are generated in Priority (e.g., Order Confirmation)[MOVE 

TO Sales Orders FORM AND SELECT Order Confirmation FROM DIRECT 

ACTIVATIONS] offer several print/send options, which typically include options to send the 

report as an e-mail attachment[SELECT Mail] or open and save the report in 

Word[SELECT Microsoft Word]. 

Moreover, Priority enables authorized users to create custom-designed Word and Excel 

templates for any system form, using Priority's Word Document Generator and Excel 

Report Generator. These templates can then be used to generate an infinite variety of 

documents that include select data fields, exported directly from Priority forms and 

reports[FROM TOP BAR, SELECT File > Send Data to Microsoft Word AND CHOOSE A 

PRE-DEFINED TEMPLATE, SHOW RESULTS IN WORD]. Such templates are particularly 

useful for printing checks directly from Priority, using bank, vendor and payment data that 

have already been recorded in Priority. Detailed instructions on designing and using Word 

and Excel templates for system data and on printing checks based on a Word template are 

provided elsewhere. 

This concludes our tour of Priority’s Office integration and synchronization tools. 

Related Documentation 
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